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1 About This Book

1.1 Audience

This book is intended for users who want to install Appeon Mobile 1.0, deploy and run the
mobile application, package and distribute the application, or configure the Appeon Server
cluster.

1.2 How to use this book

There are six chapters in this book.

Chapter 1: About This Book

A general description of this book

Chapter 2: Tutorial 1: Set up the Environment

Detailed instructions for setting up the Appeon Mobile 1.0 environment.

Chapter 3: Tutorial 2: Config, Deploy & Run the Application

Detailed instructions for configuring and deploying an existing PowerBuilder application,
and then running the application on mobile device.

Chapter 4: Tutorial 3: Develop & Debug with Appeon Mobile

High-level guidelines for developing and debugging the application with Appeon Mobile.

Chapter 5: Tutorial 4: Package & Distribute Native Mobile Apps

Detailed instructions for packaging and distributing the app as a native iOS app.

Chapter 6: Tutorial 5: Configure Appeon Server Cluster

Detailed instructions for configuring an Appeon Server cluster.

1.3 Related documents

Appeon provides the following user documents to assist you in understanding Appeon for
PowerBuilder and its capabilities:

• Introduction to Appeon:

Guides you through all the documents included in Appeon for PowerBuilder.

• New Features Guide:

Introduces new features and changes in Appeon for PowerBuilder.

• Appeon Mobile Tutorials:

Gives instructions on deploying, running, and debugging Appeon applications, distributing
native mobile apps, and configuring Appeon server clusters.

• Appeon Installation Guide:
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Provides instructions on how to install Appeon for PowerBuilder successfully.

• Development Guidelines for Appeon Mobile:

Introduces general guidelines on developing apps with Appeon Mobile.

• Migration Guidelines for Appeon Web:

A process-oriented guide that illustrates the complete diagram of the Appeon Web
migration procedure and various topics related to steps in the procedure, and includes a
tutorial that walks the user through the entire process of deploying a small PowerBuilder
application to the Web.

• Features Help for Appeon:

Provides a detailed list of supported PowerBuilder features which can be converted to the
Web/Mobile with Appeon as well as which features are unsupported.

• Appeon Developer User Guide:

Provides instructions on how to use the Appeon Developer toolbar in Appeon for
PowerBuilder.

• Workarounds & API Guide:

Provides resolutions for issues, such as unsupported features, etc,. encountered when using
Appeon for PowerBuilder.

• Appeon Workspace User Guide:

Gives a general introduction on Appeon Workspace and provides detailed instructions on
how to use the app.

• Appeon Server Configuration Guide:

Provides instructions on how to configure Appeon Server Monitor, establish connections
between Appeon Servers and database servers, and configure AEM for maintaining
Appeon Server and Appeon deployed applications.

• Web Server Configuration Guide:

Describes configuration instructions for Web Servers to work with a single Appeon Server
or an Appeon Server cluster.

• Troubleshooting:

Provides information on troubleshooting issues; covering topics, such as product
installation, application deployment, AEM, and Appeon application runtime issues.

• Appeon Performance Tuning Guide:

Provides instructions on how to modify a PowerBuilder application to achieve better
performance from its corresponding Web/mobile application.

• Testing Appeon Web Applications with QTP:

Provides instructions on how to test Appeon Web applications with QTP.
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1.4 If you need help
If you have any questions about this product or need assistance during the installation
process, access the Technical Support Web site at http://www.appeon.com/support.

http://www.appeon.com/support
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2 Tutorial 1: Set up the Environment
You will need to go through the following tasks to set up the Appeon Mobile 1.0
environment for deploying and running the mobile application:

2.1 Task 1: Prepare the machine

The simplest scenario will be used in this guide, which requires 1 Windows PC and 1 iPad or
iPhone.

• 1 Windows PC: used as the development machine and the Appeon Server

• 1 iPad or iPhone: used as the mobile client

The Appeon Mobile for .NET edition will be used to walk you through this guide, so please
prepare the environment according to the following requirements.

Software requirements for Windows PC:

• Windows 7 (32-bit or 64-bit)

Appeon Mobile 32-bit version can be installed to the 64-bit OS without any special
considerations. But if you have installed Appeon for PowerBuilder 64-bit version before
please uninstall it first. See Task 1.1: Uninstall previous version of 64-bit Appeon.

• Internet Explorer 8, 9, or 10

• PowerBuilder 9.x, 10.x, 11.x, or 12.x

• (Optional) Sybase Adaptive Server Anywhere (32-bit engine) 8.0.2, 9.0, 10.0.1, 11.0, or
12.0 (for running the demos included with the Appeon installation)

• .NET Framework 4.0

Download the .NET Framework 4.0 setup program from http://www.microsoft.com/en-us/
download/details.aspx?id=17718.

• IIS 7.5

See Task 1.2: Install IIS and Task 1.3: Configure IIS.

• Appeon Server

• Appeon Developer

See Task 2: Install Appeon Server & Appeon Developer

Software requirements for the iPad or iPhone:

• iOS 5.1 or above

• Appeon Workspace

See Task 3: Install Appeon Workspace (on the iPad or iPhone)

http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/details.aspx?id=17718
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2.1.1 Task 1.1: Uninstall previous version of 64-bit Appeon

If you are using a 64-bit machine you can install Appeon Mobile (32-bit) to the 64-bit
OS without any special considerations. But if you have a previous version of Appeon for
PowerBuilder (64-bit) already installed on this machine then you must uninstall it first.

Step 1: Open IIS Manager, right click the top node (not the website node) in the treeview
and select Stop from the popup menu. This will stop the entire IIS.

Figure 2.1: Stop the entire IIS Manager

Step 2: Close any opened window, especially Sybase PowerBuilder and IIS Manager.

Step 3: Uninstall all of the Appeon components including Appeon Server, Appeon
Developer, and Appeon Help. You will need to uninstall these components one by one.

Step 4: Verify Appeon is cleanly uninstalled by the following two steps:

• Double check the Control Panel\Programs\Programs and Features and make sure no
Appeon component is listed.

• Open a command prompt window and then type "regedit"<Enter>. Double check that no
ADT or ASN keys are listed under HKEY_LOCAL_MACHINE\SOFTWARE\Appeon
\<version_number>.

Step 5: Clear the Internet Explorer cache and temporary files.

Step 6: Delete the entire Appeon folder from C:\Users\User_Name\AppData\Roaming\.
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Step 7: Delete all the Appeon application folders from the IIS Web root. For example,
under C:\inetpub\wwwroot\ at minimum you should delete the following folders, appeon,
appeon_acf_demo, appeon_code_examples, pet_world, sales_application_demo.

Step 8: Restart the machine.

Step 9: Start IIS by right-clicking the top node in the treeview in the IIS Manager and
selecting Start from the popup menu.

After that, you can proceed to install Appeon Mobile by following steps in Task 2: Install
Appeon Server & Appeon Developer.

2.1.2 Task 1.2: Install IIS

IIS 7.5 is not installed on Windows 7 by default. You need to manually install it. Before you
install IIS 7.5 make sure you have installed .NET Framework 4.0. If it is not installed please
download the setup program from http://www.microsoft.com/en-us/download/details.aspx?
id=17718 and install .NET Framework 4.0 first.

Below are steps for installing IIS.

Step 1: Click Start and then click Control Panel. In Control Panel, click Programs and then
click Turn on or off Windows features.

Step 2: Select the check box of Internet Information Services, then expand the list and
select the items under Web Management Tools, Application Development Features and
Common HTTP Features according to the figure below. Click OK to let Windows finish
the install.

http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/details.aspx?id=17718
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Figure 2.2: Select the Web Management Tools
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Figure 2.3: Select the Application Development Features
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Figure 2.4: Select the Common HTTP Features

Step 3: After IIS is installed, go to IIS Manager, right click the Default Web Site, select
Binding, and make sure IP Address is indicated with an asterisk "*". If not, please click Edit
and select All Unassigned for the IP address.

Step 4: Run http://IP_Address:80/ in Internet Explorer. If the welcome screen displays, then
IIS is working properly.

Tip: to obtain the IP address of the server, open a command prompt window and then type
ipconfig<Enter>. Remember this IP address as it is also needed when you configure the
mobile app in Appeon Workspace.

If IIS is not working, please re-install IIS or fix the IIS configuration by following the IIS
help.

2.1.3 Task 1.3: Configure IIS

Follow steps below to grant IIS_IUSRS account with full controls to the IIS Web root folder:

Step 1: Right click C:\Inetpub\wwwroot and select Properties from the popup menu.

Step 2: On the Security tab, select IIS_IUSRS in the Group or user names list box, and
then click the Edit button.
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Figure 2.5: Select IIS_IUSRS

Step 3: Select IIS_IUSRS in the Group or user names list box, and then select the Allow
check box for the Full control.
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Figure 2.6: Select Full control for IIS_IUSRS

Step 4: Click OK to save the settings.

2.2 Task 2: Install Appeon Server and Appeon Developer

2.2.1 Task 2.1: Install Appeon Server and Appeon Developer

On the Windows PC, install Appeon Server and Appeon Developer by the following steps.

Step 1: Start IIS server: open IIS Manager, right click the top node (not the website node) in
the treeview and select Start from the popup menu.

Step 2: Launch the Appeon product setup program by double-clicking setup.exe. Click Next
until you reach the screen for selecting the product components. Make sure the checkboxes
for Appeon Server for .NET and Appeon Developer are selected.
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Step 3: Click Next until you reach the screen for specifying the IIS Web site where Appeon
Server will be installed. Make sure Select an existing Web Site and Default Web Site are
selected.

Step 4: Click Next. Choose whether to install the Demo Applications. If you have ASA
database server installed, select to install the demo; otherwise, do not install the demo since
the demo requires ASA database server to be previously installed.

Step 5: If you selected to install the Demo Applications, specify the path for the ASA
database server engine.

Step 6: Click Next until Setup begins copying files for the Appeon Server installation.

When Appeon Server installation is completed, Appeon Developer installation automatically
starts.

Step 7: Click Next until Setup begins copying files for the Appeon Developer installation.

Step 8: When the installation is completed, select the checkbox for Restart IIS Server and
Register .NET Framework 4.0 and then click Finish.

You can also restart IIS by typing iisreset in the command prompt window.

2.2.2 Task 2.2: Verify the installation

On the Windows PC, run http://IP_Address:80/. If AEM is launched successfully, then
Appeon Server is installed successfully.

2.3 Task 3: Install Appeon Workspace (on the iPad or iPhone)

On the iPad or iPhone, search for Appeon in Apple Store and then tap Install to download
and install Appeon Workspace.

You can also download Appeon Workspace from iTunes Store to your PC and then
synchronize it to the iPad or iPhone via iTunes.

2.4 Task 4: Configure the network connection

Step 1: On the Windows PC first disable all anti-virus software. It is highly likely that the
anti-virus software will prevent the Appeon Server from running properly and/or your iPad/
iPhone connecting to the Appeon Server. For example, there are known conflicts with AVG
and Avast, just to mention a few popular free anti-virus commonly used.

Step 2: On the Windows PC, turn off the Windows firewall for both the Home and Work
network locations (Control Panel > Windows Firewall).

https://itunes.apple.com/us/app/appeon/id574360543?mt=8
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Figure 2.7: Turn off the Windows firewall

Step 3: Check and make sure the Windows PC and the iPad or iPhone connected to the same
Wi-Fi router. To verify this, on the iPad or iPhone, open the Safari Web browser and type
http://Server_IP:80/. If AEM is launched successfully, it means that the Appeon Server is
properly installed and that the iPad or iPhone is able to connect to the Windows PC.

NOTE: Mobile Internet is supported in Appeon Mobile 1.0. However, in order for the
Appeon Workspace to connect to your Appeon Server you will need an external IP
address. You can verify that your external IP address is properly working by typing http://
External_IP_Address:80 into a Web browser of any device connected to the Internet. If you
get a page not found error or other HTTP error then your network is not configured properly
for external access.
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3 Tutorial 2: Config, Deploy & Run the
Application
This tutorial will use the Appeon Mobile for .NET edition to walk you through the following
tasks:

3.1 Task 1: Configure the database type

Step 1: On the Appeon Developer toolbar, click the Configure icon ( ).

Step 2: On the Appeon Developer Configuration window, click the DB Type Profile tab.

Step 3: View the Configured column of the database type used by your application, if it
displays Yes, you can skip the remaining steps in this task. Otherwise, select the database
type used by your application, and then click Configure.

Figure 3.1: DB Type Profile in ADT

Step 4: On the Database Type Profile Configuration window, do the following (take
Sybase ASA as an example):

1. Select the ODBC Interface radio button from the Database Interface option.

2. Select a data source from the Data Source dropdown list box. It can be any data source
(ODBC DSN) provided it is the same type as used by your application. It does NOT have to
be the actual ODBC DSN used by your particular application. The database type is what is
important and that a connection can be established to the specified ODBC DSN.
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3. Keep the rest as default, and then click Test Connection.

4. Make sure that the database connection is successful.

5. Click OK.

Figure 3.2: Database Type Profile Configuration

Now the Configured column of your database type will be indicated by Yes. You can select
the database type when you create the application profile for your application in Task 3:
Configure and deploy the application.

3.2 Task 2: Configure the database connection

Step 1: In the Appeon Developer Configuration window, click the Data Source Profile tab.

Step 2 -- Select Local Appeon Server from the Appeon Server dropdown list box.

Step 3: Click the Add button to create a data source in the selected Appeon Server.
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Figure 3.3: Connection Cache Profiles

Step 4 -- On the Add Data Source window, specify the data source settings. Below we take
Sybase ASA and Microsoft SQL Server database as examples.

Steps for configuring a data source for Sybase ASA database:

1. In the Name text box, input any text you like as the name of the data source.

2. Select ODBC Driver from the Driver dropdown listbox.

3. Select the data source from the ODBC Data Source dropdown listbox.

4. Input the database login user name and password respectively in the User Name text box
and the Password text box.

5. Keep the rest as default, and then click Test. Make sure the test is successful.

6. Click OK.
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Figure 3.4: Add Data Source

Steps for configuring a data source for Microsoft SQL Server database:

1. In the Name text box, input any text you like as the name of the data source.

2. Select MS SQL Server Native Driver from the Driver dropdown listbox.

3. Input the IP address or machine name of the database server in the Host field.
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4. Input the port number of the database server in the Port field.

5. Input the database name, database login user name and password respectively in the
Database Name, the User Name and the Password text boxes.

6. Keep the rest as default, and then click Test. Make sure the test is successful.

7. Click OK.

Tip: you should check with your SQL Server administrator to verify the port number, the
username, and the password are correct.
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Figure 3.5: MS SQL Server Native Driver

Now the data source you added will be listed in the Data Source Profiles tab. You can select
it when you create the application profile for your application in Task 3: Configure and
deploy the application.
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3.3 Task 3: Configure and deploy the application

Step 1: On the Appeon Developer toolbar click the first icon Config Wizard ( ).

Step 2: In the welcome screen click Next.

Step 3: Specify following settings and then click Next.

1. Specify the application profile name in the Application Profile Name text box.

2. Specify the application URL in the Web Folder text box.

3. Select a project type from the Project Type dropdown list box.

Make sure Mobile is selected from the Project Type dropdown list box. The specified text is
also used as the name of the folder created under the Web root of the Web server for storing
the files when the application is deployed.

4. Select a device type from the Device Type dropdown list box.

Tablet, Smartphone, and Both are listed for choices. For applications that are designed
for tablets, select "Tablet"; for applications that are designed for smartphones, select
"Smartphone"; for applications that are designed for both devices, select "Both".

5. Enter an app name in the Mobile App Name text box.

6. In the Mobile App Icon text box, specify an icon for your application by clicking Browse
to select the image file of the following format: PNG, GIF, JPG, BMP, and ICO. The
image that you choose will be displayed as the application icon in the Appeon Workspace.
Recommended size is 86 x 86 pixels (or above) for non-retina display and 172 x 172 pixels
(or above) for retina display. To ensure the best display quality in both high-resolution and
low-resolution screens, you must supply an image of 172 x 172 or above. The image will be
automatically adjusted to fit properly. If you leave this field empty, the default icon will be
displayed in Appeon Workspace.

7. Enter a brief description in the Mobile App Description text box. This description will
be displayed in the Appeon Workspace next to the application icon. If you leave this field
empty, no app description will be displayed in the Appeon Workspace.
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Figure 3.6: Appeon Developer Configuration Wizard

Step 4: Add the PBT from the PBT dropdown list box (and all related PBLs will be
automatically added for you) or add the PBL files individually that are used in your
application by clicking the Add File button in the PBL File List group box, and then select a
PBL version from the PBL Version dropdown list box. Click Next.
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Figure 3.7: Add the PBT in ADT Wizard

Step 5: Keep the default settings and click Next.

Since you have installed Appeon Developer and Appeon Server on the same machine, you
can directly use the Local Appeon Server profile, the Local Web Server profile, and the
Local Deployment profile, all of which are configured automatically by the product setup
program.

When you click Next the config wizard will automatically test the connection to the server.
You will not be able to proceed if the connection test failed.
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Figure 3.8: Select the Appeon Server(s) and Web Server(s)

Step 6: Select the database type used by your application and click Next.

If the required database type has not been configured, you should highlight the database type,
then click Edit, and then follow Step 4 in Task 1: Configure the database type to configure it.
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Figure 3.9: Select the database type(s)

Step 7: Click Add to specify the transaction object(s) used in your application.
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Figure 3.10: Specify the transaction object

In the Add Transaction Object window, specify the following settings:

a. Input the transaction object name used by the application to the Transaction Object text
box. Default transaction object for most PB applications is SQLCA.

b. Select the database type from the Database Type list box.

c. Select Local Appeon Server from the Appeon Server dropdown list box.

d. Select the data source from the table. The data source should connect to the same database
that the PowerBuilder application connects to. If the required data source does not exist, you
should click Add, and then follow Step 4 in Task 2: Configure the database connection to
create it.
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Figure 3.11: Select the connection cache

Tip: If you have more than one transaction object you can add additional transaction objects
by repeating the above steps.

Step 8: Click Browse to select the image file or the folder that contains the image files, if
any. Click Next.

Step 9: Click Add File or Add Directory to select the INI file, if any. Click Next.

Step 10: Click Add File or Add Directory to select any other external files such as TXT file
etc., if any. Click Next.

Step 11: In the configuration summary screen, keep the Deploy the application now option
as selected. Click Finish.

Once you click Finish, the Appeon Deployment Wizard automatically starts deploying the
application. To manually starts Appeon Deployment Wizard, you can click the Deploy icon

( ) on the Appeon Developer toolbar.
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Step 12: Click Finish when the deployment process is complete.

Figure 3.12: Appeon Deployment Wizard_sales

3.4 Task 4: Run the Web version of the application (in IE)

Before you run the application on the iPad or iPhone, make sure your application can run
successfully in the Internet Explorer Web browser (to aid debugging your application is
automatically deployed as both a Web application using Appeon Web 6.6 and a mobile
application using Appeon Mobile 1.0):

Step 1: Open Internet Explorer and navigate to the trusted sites list (Internet Option >
Security > Trusted Sites > Sites). Uncheck the HTTPS checkbox and add the IP address
of your IIS as well as the localhost. For example, if your IP address is 192.168.1.117 then it
should look as follows:
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Figure 3.13: Add the IP address of IIS
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Figure 3.14: Add the IP address of localhost

Step 2: Input the application URL in the Internet Explorer address bar and start the
application. The application URL must contain index.htm, for example http://192.168.1.117/
myApplication/index.htm.

Note: The application URL is specified in Step 3 of Task 3: Configure and deploy the
application.

Step 3: Install the Web browser plug-in, when you are prompted. You will be prompted
twice, please accept both times.

Step 4: When the application is loaded successfully in Internet Explorer, test it carefully.

If you notice any issues, please debug the application according to the Tutorial 3: Develop &
Debug with Appeon Mobile.

3.5 Task 5: Run the mobile version of the application (on the iPad
or iPhone)

Now that you have run the application successfully in IE, you are ready to run your
application on the iPad or iPhone.

Step 1: Install Appeon Workspace. See Task 3 in Tutorial 1: Set up the Environment.

Step 2: Configure the network connection. See Task 4 in Tutorial 1: Set up the Environment.

Step 3: Tap the AppeonMobile icon on your iPad or iPhone to launch Appeon Workspace.
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Step 4: Tap the New icon ( ) to the left of the title bar.

Step 5: In the App URL text box, enter the application URL in this format: http://
server_ip:port/app_name. For example, if your IIS IP address is 192.168.1.117 on port 80
and you specified myApplication in the Appeon Developer configuration as the URL folder
name then the URL would be http://192.168.1.117:80/myApplication/.

Step 6: Tap the Test Connection button to test the server connections. If successful please
proceed to Step 7, otherwise please enter the correct URL.

Step 7: Tap the Back icon ( ) on the title bar to save the information and return to the main
screen of the Appeon Workspace.

Once you return to the main screen of the Appeon Workspace, the downloading and
installation process of the application occurs automatically.

Step 8: After the installation process has completed, tap the application icon on the main
screen to run the mobile app that is installed.



Tutorial 3: Develop & Debug with Appeon Mobile Appeon for PowerBuilder 2013

Appeon Mobile Tutorials Page 31

4 Tutorial 3: Develop & Debug with Appeon
Mobile
Please keep in mind the following points when developing and debugging Appeon Mobile
applications for the iPad/iPhone. For detailed instructions on how to use the Appeon
Developer toolset you may refer to the Appeon Developer User Guide.

4.1 Point 1: iPad UI Considerations

Many aspects of the UI for mobile applications differ significantly from traditional
PowerBuilder best practices. How you layout controls on the window, the size of the
window, controls, and other visual objects, and how the user expects to interact with your
application are fundamentally different for mobile devices.

Please carefully read the Best Practices section of Development Guidelines, including the
Window subsection of the Best Practices. We have compiled valuable tips and suggestions
that will help you develop user-friendly mobile applications.

Once you have a good understanding of the Best Practices, we strongly recommend using the

Size Calculator tool ( ) in the Appeon Developer toolbar to properly size the application
windows and controls to display appropriate on the iPad or iPhone.

4.2 Point 2: Unsupported Features

Appeon Mobile supports nearly all the same features as Appeon Web. Those experienced
with Appeon Web know that it supports many powerful PB features. So you should be able to
build equally robust applications with Appeon Mobile also.

When developing applications for Appeon Mobile, it is critical to ensure that your application
does not contain unsupported features. Appeon provides several tools to assist you with this:

•
Tool 1: The UFA tool ( ) in the Appeon Developer toolbar will automatically scan your
application and list major unsupported features found based on a keyword scan.

•
Tool 2: The Code Insight tool ( ) in the Appeon Developer toolbar will pop-up a
window, when you are writing dot notation in the PB script editor, that prevents you from
writing PowerScript that is unsupported.

• Tool 3: The Features Help is a searchable online help that lists all unsupported features.

These tools have some limitations. Please keep in mind the following limitations when using
these tools:

• The UFA tool uses a keyword scan. As such, not all unsupported features can be found,
especially those that are dynamically occurring in runtime.

• The Code Insight tool is limited to unsupported PowerScript and essentially based on
keywords (like the UFA tool). As such, it will not prevent all unsupported features from
being added to the application, such as unsupported objects, unsupported expressions, etc.

http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Appeon_Developer_User_Guide/index.htm
http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Development_Guidelines_for_Appeon_Mobile/index.htm
http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Development_Guidelines_for_Appeon_Mobile/index.htm
http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Development_Guidelines_for_Appeon_Mobile/index.htm
http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Features_Help_for_Appeon_Mobile/index.htm
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We recommend you develop your mobile applications with Appeon Developer as follows:

Step 1: Use the Code Insight tool ( ) from the Appeon Developer toolbar to code
PowerScript that is compatible with Appeon Mobile. For details about how to configure and
use the Code Insight tool, see the Appeon Developer User Guide.

Step 2: Run the UFA tool ( ) from the Appeon Developer toolbar to generate the
unsupported features report. For details about how to run the UFA report, see the Appeon
Developer User Guide.

Step 3: Remove or rewrite any unsupported features found by the UFA tool. Please make
note of the unsupported features found such that in the future you do not reintroduce these
same unsupported features.

Step 4: After you have deployed the application, attempt to run the Web version in the
Internet Explorer Web browser. The Web version is based on Appeon Web 6.6 that has been
on the market for over 10 years. As such, if you find something in your application is not
working in the Web version chances are it is an unsupported feature rather than a product
bug.

Step 5: Since the UFA tool and Code Insight cannot prevent 100% unsupported features,
should you find something that does not work in the Web version please go back to the object
or area of PowerScript in question and cross-reference that with the Features Help to see if
your application contains any unsupported features.

Step 6: If after cross-referencing the Features Help you believe your application
is free of unsupported features but it fails to run or operate properly please contact
<support@appeon.com> for help.

4.3 Point 3: Previewing & Debugging

To preview the application UI and layout, use the Appeon Workspace Emulator ( ) from
the Appeon Developer toolbar.

Note: Please ensure UAC is turned off before you run the Appeon Workspace Emulator,
otherwise you may encounter an error saying "Failed writing received data to disk/
application".

To debug the application business logic, first ensure that the UFA report does not contain any
unsupported features, or at least no unsupported features in the area of the application you

are trying to debug. Then, launch the Appeon Debugger ( ) from the Appeon Developer
toolbar, which will load the Web version of your application in the IE Web browser.

The Appeon Debugger requires the Microsoft Script debugger to be installed on your system
and that your Internet Explorer is version 8, 9 or 10. There are also special configurations
you need to perform in the Appeon Developer and Internet Explorer. Please see the
Appeon Developer User Guide for more information about how to properly configure your
environment for the Appeon Debugger.

Please note that Appeon Mobile 1.0 does not contain a mobile-specific debugger, so we
have included the Web debugger in lieu. While not exactly the same, it can still help to
identify problems in the application business logic or areas that Appeon is having trouble
converting.

http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Appeon_Developer_User_Guide/index.htm
http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Appeon_Developer_User_Guide/index.htm
http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Appeon_Developer_User_Guide/index.htm
http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Features_Help_for_Appeon_Mobile/index.htm
http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Features_Help_for_Appeon_Mobile/index.htm
http://www.appeon.com/support/documents/appeon_online_help/mergedProjects/Appeon_Developer_User_Guide/index.htm
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5 Tutorial 4: Package & Distribute Native
Mobile Apps

5.1 Overview

After you successfully deploy a PowerBuilder application as a native mobile application
using the Appeon Developer Toolbar, you can choose to run the app immediately in Appeon
Workspace, or package the app and distribute it to the iOS App Store. By distributing the app
to the App Store, it can be downloaded and installed just like other native iOS apps. In this
section, you will go through all the required steps for packaging the distributing an Appeon
Mobile app as a standalone native iOS app:

1. Task 1: Generate the Xcode project.

2. Task 2: Prepare a Mac machine and your Apple ID

3. Task 3: Enroll in an Apple Developer Program

4. Task 4: Create & install distribution certificates and provisioning profiles.

5. Task 5: Create the app archive.

6. Task 6: Distribute the app archive.

5.2 Task 1: Generate the Xcode project

Step 1: Use the Package tool in the Appeon Developer toolbar to package the app files into
an Xcode project.

During the package process, you will be able to specify the settings, such as the app name,
icons, etc., that are required by the Xcode project. See the Packaging a native mobile project
section in Appeon Developer User Guide for detailed instructions.

After the package process is complete, you will find the following two zip packages
generated under the specified destination folder.

• The zip package of the application.

• AppeonMobile.framework.zip: this zip package is necessary for all apps (including the
customized Appeon Workspace) to be distributed on iOS.

Step 2: Extract the above two zip packages respectively and then copy the extracted
AppeonMobile.framework folder into the reference folder under the extracted app package.

The following screenshot shows the reference folder where the AppeonMobile.framework
folder should be copied.
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Figure 5.1: reference folder

The following screenshot shows the AppeonMobile.framework folder and the subfolders
and files it contains.

Figure 5.2: AppeonMobile.framework folder

Step 3: Copy the entire app folder to a Mac machine.

The following screenshot shows the subfolders that the app folder (Sales App Demo for
example) contains.
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Figure 5.3: app folder

5.3 Task 2: Prepare the Mac machine and your Apple ID

5.3.1 Task 2.1: Prepare the Mac machine

Buy a Mac machine and install Xcode on the Mac machine.

You will need to have a Mac machine with the Xcode tool installed already to

1. create and install the distribution certificate and the provisioning profile;

2. run the Xcode project and create the app archive;

3. distribute the app archive.

5.3.1.1 Install Xcode

Click https://developer.apple.com/xcode/ to download and install the Xcode tool.

You will need an Apple ID registered as an Apple Developer to access the Xcode tool.
See Task 2.2 Create an Apple ID to create an Apple ID, and then sign in with your Apple
ID, follow the onscreen instructions to register your Apple ID as an Apple developer, and
download and install the Xcode tool at the above mentioned website.

For more information on Xcode, see Xcode User Guide.

5.3.2 Task 2.2: Create an Apple ID

Follow the onscreen instructions on My Apple ID to create an Apple ID if you do not have
one.

5.4 Task 3: Enroll in an Apple Developer Program
Enroll in an Apple Developer program at https://developer.apple.com/programs/start/ios/.

https://developer.apple.com/xcode/
https://developer.apple.com/library/ios/#documentation/ToolsLanguages/Conceptual/Xcode_User_Guide/000-About_Xcode/about.html
https://appleid.apple.com/cgi-bin/WebObjects/MyAppleId.woa/wa/createAppleId?localang=en_US
https://developer.apple.com/programs/start/ios/
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Carefully compare the programs and choose one that suits you best, because different
distribution types (App Store, Ad Hoc, In-House, etc.) will be available in different programs,
for example, App Store Distribution is available in iOS Developer program only, while In-
House Distribution is available in iOS Developer Enterprise program only.

Here is a brief introduction to the three distribution types that are commonly used and are
provided with detailed instructions in Section 5.7, “Task 6: Distribute the app archive” in this
tutorial:

• App Store Distribution: allows you to submit the app for publication to the iOS App
Store.

You would need to enroll in the iOS Developer program.

• In-House Distribution: allows you to install the app to an unlimited number of devices
inside your company.

You would need to enroll in the iOS Developer Enterprise program.

• Ad Hoc Distribution: allows you to install the app on a limited number (up to 100) of
registered devices.

You would need to enroll either in the iOS Developer program or the iOS Developer
Enterprise program. And you would need to register the devices by their unique device ID
(UDID) and add them to the provisioning profile. For details, refer to Registering Devices
Using Member Center in Apple document App Distribution Guide.

Figure 5.4: Compare programs

http://developer.apple.com/library/ios/#documentation/IDEs/Conceptual/AppDistributionGuide/MaintainingCertificatesandProvisioningAssets/MaintainingCertificatesandProvisioningAssets.html#//apple_ref/doc/uid/TP40012582-CH20-SW24
http://developer.apple.com/library/ios/#documentation/IDEs/Conceptual/AppDistributionGuide/MaintainingCertificatesandProvisioningAssets/MaintainingCertificatesandProvisioningAssets.html#//apple_ref/doc/uid/TP40012582-CH20-SW24
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5.5 Task 4: Create & install distribution certificates and
provisioning profiles
This section introduces how to create and install the distribution certificates and the
provisioning profiles.

5.5.1 Task 4.1: Create & install distribution certificates

Before you can create and install the provisioning profile, you need to create and install the
distribution certificates. You only need to install the distribution certificates for the very first
time. Follow steps below to create and install them.

Step 1: On your Mac machine, log in to the Member Center with your Apple ID and
Password.

Figure 5.5: Member Center

Step 2: Click the icon or text for Certificates, Identifiers & Profiles under Developer
Program Resources.

Figure 5.6: Certificates, Identifiers & Profiles

http://developer.apple.com/membercenter
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Step 3: Choose Certificates > Distribution, click the add certificate icon ( ), and then
drag down the page and click Worldwide Developer Relations Certificate Authority to
download the AppleWWDRCA.cer.

Figure 5.7: Download the AppleWWDRCA.cer

Step 4: Double-click the downloaded AppleWWDRCA.cer to open the Keychain Access and
install it.

Step 5: Choose Keychain Access > Certificate Assistant > Request a Certificate From a
Certificate Authority....

Figure 5.8: Request a Certificate

Step 6: In the Certificate Assistant dialog box, do the following:

1. In the User Email Address text box, enter your email address (use the same address as
you used to register in the iOS Developer Program);
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2. In the Common Name text box, enter a name (use the same name as you used to register
in the iOS Developer Program);

3. In the CA Email Address text box, enter your CA email address;

4. Select the Save to disk radio button and click Continue.

Figure 5.9: Certificate Assistant

Step 7: Specify a filename (usually the CertifocateSigningRequest.certSigningRequest by
default) and click Save.

The CertifocateSigningRequest.certSigningRequest file is then saved, and you are ready to
submit the generated CSR file.

Step 8: Go back to Certificates, Identifiers & Profiles, select a certificate type and then
click Continue. On the page that appears, read the information and click Continue again.

Step 9: Click Choose File to select the saved CSR
(CertifocateSigningRequest.certSigningRequest) file, and then click Generate.

Step 10: Click Download.
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Figure 5.10: Download Distribution Certificate

Step 11: Double-click the downloaded distribution certificate (ios_distribution.cer) file to
open the Keychain Access and install your certificate in your default keychain (usually the
login keychain). The certificate is then listed in the Keychain, as shown in the following
figure.

Figure 5.11: Installed Certificate

5.5.2 Task 4.2: Create & install distribution provisioning profiles

Depending on how you will distribute the app (App Store, In-House, or Ad Hoc), you need to
create different distribution provisioning profiles.
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The steps for creating the different distribution provisioning profiles are similar. To create a
Store provisioning profile or an In-House provisioning profile, you select 1) an App ID and
2) a single distribution certificate. To create an Ad Hoc provisioning profile, you select 1)
an App ID, 2) a single distribution certificate, and 3) multiple test devices. For details, refer
to the below steps, or refer to Creating Store Provisioning Profiles, and Creating Ad Hoc
Provisioning Profiles in the Apple document App Distribution Guide.

Step 1: Go back to Certificates, Identifiers & Profiles, then choose Provisioning Profiles >

Distribution, and then click the add icon ( ).

Step 2: Select a distribution type and click Continue in the Select Type tag.

You will be provided with different distribution types according to the programs you enrolled
in. If you enrolled in the Apple Developer program, you would choose between App Store
and Ad Hoc; if you enrolled in the Apple Developer Enterprise program, you would choose
between Ad Hoc and In-House.

Step 3: Select your App ID and click Continue.

Step 4: Select the distribution certificate you have created in Task 4.1: Create & install
distribution certificates and click Continue.

Step 5: Select the devices you want to use for testing, and click Continue.

Note: This step is only required for creating the Ad Hoc provisioning profile.

Step 6: Enter a profile name and click Generate.

Step 7: After the profile is generated, click Download to download and use it.

Step 8: Double-click the downloaded file to install the provisioning profile in Xcode.

Step 9: In Xcode, choose Window > Organizer, and then click Device. The installed
provisioning file is listed.

Figure 5.12: Installed provisioning profile

Now that you have finished creating and installing the distribution certificate and the
provisioning profile containing code signing, you are ready to create the app archive.

5.6 Task 5: Create the app archive
Since you have configured all the required information for the Xcode project, such as, the app
icons, URL, etc., by using the Package tool in the Appeon Developer Toolbar, you are ready
to create an app archive right away.

Step 1: In the extracted app package folder, double-click the EnoNativeApp.xcodeproj
project to open the Xcode.

Make sure you have extracted the zip packages and copied the extracted
AppeonMobile.framework folder to the reference folder according to Task 1: Generate the
Xcode project.

http://developer.apple.com/library/ios/#documentation/IDEs/Conceptual/AppDistributionGuide/SubmittingYourApp/SubmittingYourApp.html#//apple_ref/doc/uid/TP40012582-CH9-SW8
http://developer.apple.com/library/ios/#documentation/IDEs/Conceptual/AppDistributionGuide/TestingYouriOSApp/TestingYouriOSApp.html#//apple_ref/doc/uid/TP40012582-CH8-SW4
http://developer.apple.com/library/ios/#documentation/IDEs/Conceptual/AppDistributionGuide/TestingYouriOSApp/TestingYouriOSApp.html#//apple_ref/doc/uid/TP40012582-CH8-SW4
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Step 2: Choose Product > Scheme > Edit Scheme to open the scheme editor, as shown in
the following figure.

Figure 5.13: Edit Scheme

Step 3: In the scheme editor, do the following:

1. In the left column, select Archive;

2. Select the project from Scheme;

3. Select iOS Device from Destination;

4. Select Release from Build Configuration;

5. Modify the archive name or use the default name in the Archive Name field.

6. Click OK to save the settings.
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Figure 5.14: Archive Release

Step 4: (Optional) Click the target project for the app, select Summary, and then configure
the Xcode project for distribution. All the information specified in the Appeon Developer
Package tool can be reconfigured here and you can also configure those that are not listed
in the Appeon Developer Package tool (only the required information are listed for
configuration in the Appeon Developer Package tool).

For details, read Configuring Your Xcode Project for Distribution in the Apple document
App Distribution Guide.

Step 5: Select Building Settings, drag down the screen to find the Code Signing group, then
click Release, and then select the corresponding code signing profile.

Figure 5.15: Code signing

Step 6: In Xcode, choose Product > Archive.

https://developer.apple.com/library/ios/#documentation/IDEs/Conceptual/AppDistributionGuide/ConfiguringYourApp/ConfiguringYourApp.html#//apple_ref/doc/uid/TP40012582-CH13-SW1
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Figure 5.16: Archive

After the project is built successfully, it will appear in the Archives organizer, as shown
below.

Figure 5.17: Archive list

Now the app archive is ready. You can submit the archive to App Store or save the file for
enterprise or Ad-Hoc distribution.

5.7 Task 6: Distribute the app archive

Xcode allows you to distribute the app archive in the following methods:

• App Store distribution: submits the app for publication to the iOS App Store. Refer to
Section 5.7.1, “Method 1: App Store distribution” for detailed instructions.

• In-House distribution: installs the app to an unlimited number of devices inside your
company. Refer to Section 5.7.2, “Method 2: In-house or Ad-Hoc distribution” for detailed
instructions.

• Ad Hoc distribution: installs the app on a limited number (up to 100) of registered
devices. Refer to Section 5.7.2, “Method 2: In-house or Ad-Hoc distribution” for detailed
instructions.
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The detailed instructions for Ad Hoc distribution and In-House distribution are the same,
though their provisioning profiles are different.

• Export as Xcode Archive: this method is not relevant to our distribution strategy, hence it
is left out of this tutorial.

5.7.1 Method 1: App Store distribution

Step 1: In the Archives organizer, select the application archive you want to distribute, and
click Distribute.

Step 2: Select Submit to the iOS App Store and click Next. Then follow instructions in App
Store Submission Tutorials to submit your app to the iOS App Store.

5.7.2 Method 2: In-house or Ad-Hoc distribution

Step 1: In the Archives organizer, select the application archive you want to distribute.

Step 2: Optionally, click the Validate button.

You can validate the archive and fix any problems before distributing it.

Step 3: Click the Distribute button.

Step 4: Select Save for Enterprise or Ad-Hoc Deployment and click Next.

Figure 5.18: Select distribution method

Step 5: Choose your distribution certificate (the one contained in your distribution
provisioning profile) from the Code Signing Identity pop-up menu and then click Next, as
shown in the following figure.

http://developer.apple.com/library/ios/#documentation/ToolsLanguages/Conceptual/YourFirstAppStoreSubmission/AboutYourFirstAppStoreSubmission/AboutYourFirstAppStoreSubmission.html
http://developer.apple.com/library/ios/#documentation/ToolsLanguages/Conceptual/YourFirstAppStoreSubmission/AboutYourFirstAppStoreSubmission/AboutYourFirstAppStoreSubmission.html
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Figure 5.19: Choose an identity

Step 6: Specify the file name and the location of the IPA file and the relevant settings.

• Select the Save for Enterprise Distribution check box.

• In the Application URL field, specify the URL to the IPA file on a server.

• In the Title field, specify the app name that will be displayed during installation.

• In the Large Image URL and the Small Image URL fields, specify the app icon that will
be displayed during installation.

• Click Save.

A .ipa file and a .plist file will be generated. The above settings will be saved in an XML
manifest (.plist) file.
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Figure 5.20: Save for Enterprise Distribution

Now you can distribute the app to your users in the following four ways:

• Distribute the .ipa file and .plist file to your users, and users perform the installation using
iTunes. See the section called “Install apps using iTunes” for detailed instructions.

• Distribute the .ipa file and .plist file to your users, and users perform the installation using
iPhone Configuration Utility or Apple Configurator (Using Apple Configurator is left
out in this tutorial). See the section called “Install apps using iPhone Configuration Utility”
for detailed instructions.

• Post the .ipa file and .plist file on a secure Web server, and users perform the installation
wirelessly. See the section called “Install apps wirelessly” for detailed instructions.

• Use your MDM server to instruct managed devices to install the app, if your MDM server
supports it. This is left out in this tutorial.

For more information on deploying apps, refer to Distributing Enterprise Apps for iOS
Devices.

5.7.2.1 Install apps using iTunes

Step 1: Copy the .ipa file for the app to a machine (either Windows or Mac) with iTunes
already installed.

Step 2: In iTunes, choose File > Add to Library, and then select the .ipa file.

https://developer.apple.com/library/ios/#featuredarticles/FA_Wireless_Enterprise_App_Distribution/Introduction/Introduction.html
https://developer.apple.com/library/ios/#featuredarticles/FA_Wireless_Enterprise_App_Distribution/Introduction/Introduction.html
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Step 3: Connect a device to the computer, and then select it in the Device list in iTunes.

Step 4: Click the Apps tab, and then select the Sync Apps checkbox and the app in the list.

Step 5: Click Apply (or Sync).

If your user's computers are managed, you can deploy the files to their computers and ask
them to sync their device. iTunes automatically installs the files found in iTunes Mobile
Application and Provisioning Profiles folders.

5.7.2.2 Install apps using iPhone Configuration Utility

Step 1: Copy the .ipa file for the app to a machine (either Windows or Mac) with iPhone
Configuration Utility already installed.

Step 2: In iPhone Configuration Utility, choose File > Add to Library, and then select
the .ipa file.

Step 3: Connect a device to the computer, and then select it in the Device list.

Step 4: Click the Applications tab, and then select the .ipa file.

Step 5: Click Install.

5.7.2.3 Install apps wirelessly

Step 1: Construct and configure the server.

1. Install IIS on the server.

2. Copy the app (.ipa) file, the manifest (.plist) file, and the icons to a location on the IIS
website that is accessible to the users.

3. Create a page that links to the manifest file.

Here is a sample link:

<a href="itms-services://?action=download-manifest&url=http://example.com/
?manifest.plist">Install App</a>

Step 2: Set the MIME type of the server, so the server can correctly transfer the manifest file
and the application.

• For Mac OS X Server, use the Server Admin to add the following MIME types to the Web
service's MIME Types settings:

application/octet-stream ipa

text/xml plist

• For IIS, use the IIS Manager to add the following MIME types on the server's Properties
page:

.ipa application/octet-stream

.plist text/xml

Now your app is ready for installation.
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Step 3: Distribute the URL for downloading the manifest file by SMS or email to the users.

Step 4: The user clicks the URL to download the manifest file from the website to the iOS
device, and the manifest file instructs the device to download and install the apps referenced
in the manifest file.
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6 Tutorial 5: Configure Appeon Server Cluster
Appeon provides its own tools and plug-ins to configure an Appeon Server cluster and
implement the load balancing and failover functionalities. An Appeon Server cluster is
essentially a group of application servers, each with Appeon Server and Appeon plug-in
installed.

Following are high level steps for configuring an Appeon Server cluster. For detailed
instructions, you may need to go through the documents and sections as specified below.

1. Task 1: Install Appeon Server to multiple application servers.

2. Task 2: Create Appeon Server cluster in AEM.

3. Task 3: Configure the Web server for the Appeon Server cluster.

4. Task 4: Install an Appeon application to the Appeon Server cluster and Web server(s).

6.1 Task 1: Install Appeon Server to multiple application servers

Step 1: Set up a group of application servers.

The application server must be of the same type and of the same version. Appeon supports
the following application server types: .NET IIS, JBoss, WebLogic, WebSphere, JEUS,
EAServer, and NetWeaver. For more details, refer to the Appeon Server requirements
section in Appeon Installation Guide.

Step 2: Install Appeon Server to each application server by following the installation
instructions in the Appeon Server installation section in Appeon Installation Guide. In the
Select Components page, make sure you select to install the appropriate edition of Appeon
Server, for example, select Appeon Server for .NET if the application server is .NET/IIS.

6.2 Task 2: Create Appeon Server cluster in AEM

Once you have installed Appeon Server to several application servers, you can use the AEM
Cluster tool to create an Appeon Server cluster and configure the load balancing and failover
settings of the cluster. The following are the detailed instructions.

Step 1: Log into AEM. Each Appeon Server has an AEM. You only need to log in to one of
them for the cluster, make configurations there, and then synchronize the settings to the other
AEMs in the cluster.

Step 2: In the Server | Resource | Cluster tool, add the Appeon Servers one by one. It is
important that the first Appeon Server you add is the one hosting the AEM you are currently
logged into.

1. Click the Add Appeon Server button under the Cluster Server List table. The Add New
Appeon Server page opens.

2. Verify that the Appeon Server to be configured is running and provide the required
information (IP address, port, AEM user name, and password). For example:



Tutorial 5: Configure Appeon Server Cluster Appeon for PowerBuilder 2013

Appeon Mobile Tutorials Page 51

• IP address: 161.0.0.1

Use the IP address or machine name of the Appeon Server when adding an Appeon
Server. Do not use "localhost" or "127.0.0.1". The IP address or machine name and port
number must match the settings of HTTP listeners in the application server.

• Port: 80

• AEM User Name: admin

• AEM Password: admin

3. Click the Save and Add button to add the other Appeon Servers. The program will
automatically test the connection and add the Appeon Server if the test is successful.

Adding an Appeon Server will succeed only if:

• The Appeon Server is new to AEM.

• The information provided is correct.

• The Appeon Server is running.

• The first Appeon Server that you add is the one hosting AEM you are currently logged
into.

The Appeon Servers listed in the Cluster Server List group will work as a cluster in
supporting the requests from their associated Web server.

Step 3: Configure the load balancing and the fail-over settings by following instructions in
the Cluster section in the Server Configuration Guide.

Step 4: Check status of Appeon Servers and verify that all servers are running.

Step 5: Click Save to synchronize AEM settings to the other servers in a cluster.

Once an Appeon Server is added to the cluster server list, you can use the AEM which
maintains the list to manage all servers in the cluster. Whenever you change the settings
of this AEM and click Save, the settings will be saved to the other servers in the cluster.
Therefore, you do not need to repeat the configuration in each AEM. However, not all of the
AEM settings will be synchronized, because some settings are not necessary to be the same
for all servers.
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Figure 6.1: Cluster

6.3 Task 3: Configure the Web server for the Appeon Server cluster

6.3.1 Task 3.1: Install the Appeon Server Web Component on Web server

Step 1: Set up one or more separate Web server(s).

For detailed system requirements, refer to the (Optional) Web server requirements section
in Appeon Installation Guide.

Step 2: Install the Appeon Server Web Component on each Web server.

For detailed instructions, please follow the installation instructions in Appeon Server Web
Component installation section in Appeon Installation Guide.

6.3.2 Task 3.2: Configure the Web server with the Appeon plug-in

6.3.2.1 Type 1: IIS Web server

6.3.2.1.1 Method 1: Automatic configuration

Installing Appeon Cluster Plug-in

Step 1: Get the Appeon cluster plug-in installation package.

After you install Appeon Server Web Component, you can find the Appeon Cluster
plugin folder under the WebComponent2013\appeon\IISSupport\ directory, and this folder
is the Appeon cluster plug-in installation package, as shown in the following figure.
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Figure 6.2: Appeon Cluster plugin

Step 2: Copy the Appeon Cluster plugin folder to the Web server in the cluster, and then
double-click AppeonCluster.exe under this folder.

The Appeon Cluster Plug-in Installation Wizard is displayed.

Step 3: Select Create an Appeon Cluster Plug-in on a new Web site, and click Next.

If you want to install to an existing Web site, select Create an Appeon Cluster Plug-in on
an existing Web site, and click Next.
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Figure 6.3: Create plugin on a Web site

Step 4: To create the Appeon cluster plug-in on a new Web site, configure Description, Port
and Home Directory, then click Next.

The new Web site will be created.
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Figure 6.4: Configure the Web site

Step 5: Select the Appeon cluster plug-in run mode (32 bit or 64 bit), and click Next.

Figure 6.5: Select run mode
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Step 6: Specify the Windows administrator user name and password, and click Next. Make
sure to input the correct user name and password, otherwise you may not be able to access the
Appeon Cluster Manager in Internet Explorer.

Figure 6.6: Windows administrator username and password

Step 7: When the plug-in is created successfully, click Finish to exit the Appeon Cluster
Plug-in Installation Wizard.
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Figure 6.7: Create the plug-in

6.3.2.1.2 Method 2: Manual configuration

Configuring Windows IIS 7.x with .NET server

Choose an existing Web site, or create a new site. The Default Web Site will be used as
examples in the following guide.

1. Copying the Appeon Server Web component to the Web root of the IIS server.

During the installation of Appeon Server Web Component, an IISSupport folder will
be created under the directory which (if you did not specify) is C:\Program Files\Appeon
\WebComponent2013\appeon by default. IISSupport contains files and components that
help IIS 7.x run with the Appeon Server cluster. Check if the appeon\IISSupport folder
exists under the Web root of the IIS server, if not, perform the following steps to copy it
from an existing Appeon Server Web Component installation directory:

Step 1: Create an appeon folder under the Web root of IIS server (for example, C:
\inetpub\wwwroot).

Step 2: Copy the IISSupport folder from the installation path to the created appeon folder
(for example, C:\Inetpub\wwwroot\appeon).

2. Creating a virtual directory.

Step 1: Open Control Panel | Administrative Tools | Internet Information Service
(IIS) Manager.

Step 2: Right click the Default Web Site and select Add Virtual Directory.



Tutorial 5: Configure Appeon Server Cluster Appeon for PowerBuilder 2013

Appeon Mobile Tutorials Page 58

Step 3: Input the alias name, for example, "ApbCluster".

Step 4: Choose a local path in the Physical path box; for example, "d:\iisplugin".

Step 5: Click OK.

Figure 6.8: Add virtual directory

Step 6: Right click the ApbCluster Virtual Directory and select Edit Permissions.

Step 7: Choose the Security tab page, select IIS_IUSRS (WIN-TDTR6ISIYCD
\IIS_IUSRS) in the Group or user names list box, and then click the Edit button.
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Figure 6.9: appeoncluster properties

Step 8: Select IIS_IUSRS (WIN-TDTR6ISIYCD\IIS_IUSRS) in the Group or
user names list box, and then select Modify and Write in the Allow column of the
Permissions for IIS_IUSRS list box.
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Figure 6.10: appeoncluster permissions

Step 9: Click OK to go back to the IIS window.

3. Copying Appeon plug-in (ApbCluster.dll or ApbCluster64.dll).

Copy the ApbCluster.dll (for 32-bit OS) or ApbCluster64.dll (for 64-bit OS) plug-in
from appeon\IISSupport\modules to the newly created virtual directory (d:\iisplugin in this
guide) .

In the 64-bit OS, you can either use ApbCluster.dll or ApbCluster64.dll. If you
use ApbCluster.dll, you will need to set the Enable 32-Bit Applications to True
for the AppeonAppPool application pool, as shown in figure below. If you use
ApbCluster64.dll, then set this option to False.

4. Editing Appeon Cluster configuration file (cluster-config.xml).

Step 1: Copy the cluster-config.xml configuration file to the newly created virtual
directory ("d:\iisplugin" in this guide).

cluster-config.xml resides in the %appeon%\plugin\IIS directory under the Appeon
Server installation directory. You can get it from any machine with Appeon Server .NET
installed.

Step 2: Modify the following information in the cluster-config.xml file: Appeon Server IP
address, Appeon Server port number, and load balancing algorithm.
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<?xml version="1.0" encoding="UTF-8" ?>
<cluster-config local="true" log="debug" timeout="30" polling="5" 
arithmetic="sequence">
    <extention>/ApbCluster/ApbCluster.dll</extention>
    <filters>
        <filter>/AEM</filter>
        <filter>/servlet</filter>
        <filter>/reportfile</filter>
        <filter>/imagefile</filter>
        <filter>/dwfile</filter>
        <filter>/ajsdown</filter>
    </filters>
    <servers>
        <server host="192.0.0.168" port="88"/>
        <server host="192.0.3.131" port="80"/>
        <server host="192.0.3.145" port="80"/>
    </servers>
</cluster-config>

Notes:

• Local specifies whether to read the configurations on the local server or the cloud
server. For the cloud server, set Local to False.

• log specifies the level of information to be recorded in the log file. It can be set to the
following level: debug, info, warning, error, or off.

• timeout specifies the number of seconds the Web server waits between sending
an HTTP request to Appeon Server and receiving information from it. The HTTP
connection timeout value is 2 times of this value.

• polling indicates the number of seconds when the configurations will be read again.

• arithmetic="random" indicates that the random algorithm is used to pick an Appeon
Server; arithmetic="sequence" indicates that the round-robin algorithm is used.

• extention specifies the location of the virtual directory which contains ApbCluster.dll
(or ApbCluster64.dll), that is /virtual-directory-alias-name/ApbCluster.dll (/ApbCluster/
ApbCluster.dll in this guide).

• filter specifies the type of pages to redirect.

• host indicates the IP address (recommended) or machine name of the Appeon Server.

• port indicates the port number of the Appeon Server.

5. Installing Appeon plug-in as ISAPI Filters.

Step 1: Open Control Panel | Administrative Tools | Internet Information Services
(IIS) Manager.

Step 2: Click the Default Web Site and then double-click ISAPI Filters on the right side.

Step 3: Right-click the blank area on the ISAPI Filters page, and click Add.
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Step 4: Input ApbCluster in the Filter name box and specify ApbCluster.dll (or
ApbCluster64.dll) as the ISAPI filter in the Executable box (d:\iisplugin\ApbCluster.dll
in this guide). Click OK.

Figure 6.11: Add ISAPI filter

6. Creating the redirector configuration file.

Step 1: Create the redirector configuration file as the name ApbCluster.cfg under the
virtual directory (d:\iisplugin in this guide).

Step 2: Copy and paste the following to the file:

Extension_URI=/ApbCluster/ApbCluster.dll   
MatchExpression=/AEM
MatchExpression=/servlet
MatchExpression=/reportfile
MatchExpression=/imagefile
MatchExpression=/dwfile
MatchExpression=/ajsdown
Log=On

Notes:

• The Extension_URI command points to the virtual directory where ApbCluster.dll
resides, that is /virtual-directory-alias-name/ApbCluster.dll (/ApbCluster/ApbCluster.dll
in this guide).

• The MatchExpression command specifies the pages to be redirected.

• The Log command specifies whether logging is enabled. On indicates logging is
enabled; Off indicates logging is disabled.

• The TimeOut command specifies the number of seconds the Web server waits between
sending an HTTP request to Appeon Server and receiving information from it. The
HTTP connection timeout value is 2 times of this value.

• The commands and parameters are case insensitive.

7. Setting ISAPI and CGI Restrictions.
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Step 1: Open Control Panel | Administrative Tools | Internet Information Services
(IIS) Manager.

Step 2: Right-click the local machine, and then double-click ISAPI and CGI Restrictions
on the right side.

Step 3: Right-click the blank area of the ISAPI and CGI Restrictions page and click
Add.

Step 4: Specify the local path of ApbCluster.dll (or ApbCluster64.dll) in the ISAPI
or CGI path box and input ApbCluster in the Description box, and then select Allow
extension path to execute.

Step 5: Click OK.

Figure 6.12: Add ISAPI or CGI

8. Enabling ISAPI-dll.

Step 1: Open Control Panel | Administrative Tools | Internet Information Services
(IIS) Manager.

Step 2: Expand the Default Web Site, click ApbCluster, and then double-click Handler
Mappings on the right side.

Step 3: Right-click ISAPI-dll, and select Edit Feature Permissions.

Step 4: Select Read, Script, Execute, and click OK.

Figure 6.13: Edit feature permissions
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9. Adding MIME type.

Add a MIME type for loading the files with no extensions or MIME type definition.

Step 1: Click the Default Web Site and then double-click MIME Types on the right of
the page.

Step 2: Right-click the blank area of the MIME Types page, and click Add.

Step 3: Specify the following settings:

• Extension: *

• MIME Type: application/octet-stream

Step 4: Click OK.

Figure 6.14: Add MIME type

10.Restarting IIS.

Restart IIS to make the new settings effective.

Configuring Windows IIS 6.0 with .NET server

Choose an existing Web site, or create a new site. The following takes the existing Default
Web Site as an example.

1. Copying the Appeon Server Web component to the Web root of the IIS server.

During the installation of Appeon Server Web Component, an IISSupport folder will
be created under the directory which (if you did not specify) is C:\Program Files\Appeon
\WebComponent2013\appeon by default. IISSupport contains files and components that
help IIS 6.0 run with the Appeon Server cluster. Check if the appeon\IISSupport folder
exists under the Web root of the IIS server, if not, perform the following steps to copy it
from an existing Appeon Server Web Component installation directory:

Step 1: Create an appeon folder under the Web root of IIS server (for example, C:
\inetpub\wwwroot).

Step 2: Copy the IISSupport folder from the installation path to the created appeon folder
(for example, C:\inetpub\wwwroot\appeon).

2. Specifying properties of IIS Web site.

Step 1: Open Control Panel | Administrative Tools | Internet Service Manager.
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Step 2: Right click Web Sites | Default Web Site and select Properties.

Step 3: In the Default Web Site Properties window, select the Home Directory tab and
set the Execute permissions to Scripts only.

Figure 6.15: Web site properties

3. Creating virtual directory.

Step 1: Right click the Default Web Site and select New | Virtual Directory.

Step 2: Input the alias name (for example, "ApbCluster"), and select a mapping directory
(for example, "d:\iisplugin").

Step 3: Allow the following permissions to the mapping directory: Read, Run scripts
(such as ASP), and Execute (such as ISAPI application or CGI)
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Figure 6.16: Virtual directory

4. Copying Appeon plug-in.

Copy the ApbCluster.dll (for 32-bit OS) or ApbCluster64.dll (for 64-bit OS) plug-in
from appeon\IISSupport\modules to the newly created virtual directory (d:\iisplugin in
this guide) .

In the 64-bit OS, you can either use ApbCluster.dll or ApbCluster64.dll. If you
use ApbCluster.dll, you will need to set the Enable 32-Bit Applications to True
for the AppeonAppPool application pool, as shown in figure below. If you use
ApbCluster64.dll, then set this option to False.

5. Editing Appeon Cluster configuration file.

Step 1: Copy the configuration file Cluster-config.xml to the newly created virtual
directory ("d:\iisplugin" in this guide).

cluster-config.xml resides in the %appeon%\plugin\IIS directory under the Appeon
Server installation directory. You can get it from any machine with Appeon Server .NET
installed.

Step 2: Modify the following information in the cluster-config.xml file: Appeon Server IP
address, Appeon Server port number, and load balancing algorithm, etc.
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<?xml version="1.0" encoding="UTF-8" ?>
<cluster-config local="true" log="debug" timeout="30" polling="5" 
arithmetic="sequence">
    <extention>/ApbCluster/ApbCluster.dll</extention>
    <filters>
        <filter>/AEM</filter>
        <filter>/servlet</filter>
        <filter>/reportfile</filter>
        <filter>/imagefile</filter>
        <filter>/dwfile</filter>
        <filter>/ajsdown</filter>
    </filters>
    <servers>
        <server host="192.0.0.168" port="88"/>
        <server host="192.0.3.131" port="80"/>
        <server host="192.0.3.145" port="80"/>
    </servers>
</cluster-config>

Notes:

• Local specifies whether to read the configurations on the local server or the cloud
server. For the cloud server, set Local to False.

• log specifies the level of information to be recorded in the log file. It can be set to the
following level: debug, info, warning, error, or off.

• timeout specifies the number of seconds the Web server waits between sending
an HTTP request to Appeon Server and receiving information from it. The HTTP
connection timeout value is 2 times of this value.

• polling indicates the number of seconds when the configurations will be read again.

• arithmetic="random" indicates that the random algorithm is used to pick an Appeon
Server; arithmetic="sequence" indicates that the round-robin algorithm is used.

• extention specifies the location of the virtual directory which contains ApbCluster.dll
(or ApbCluster64.dll), that is /virtual-directory-alias-name/ApbCluster.dll (/ApbCluster/
ApbCluster.dll in this guide).

• filter specifies the type of pages to redirect.

• host indicates the IP address (recommended) or machine name of the Appeon Server.

• port indicates the port number of the Appeon Server.

6. Installing IIS filter.

Step 1: Right click the Default Web Site and select Properties.

Step 2: In the Default Web Site Properties window, select the ISAPI Filters tab. Click
Add to add ApbCluster.dll (or ApbCluster64.dll) as the ISAPI filter. Click OK.

7. Creating redirector configuration file.
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Create the redirector configuration file as the name ApbCluster.cfg under the virtual
directory d:\iisplugin and copy the following commands to the file:

Extension_URI=/ApbCluster/ApbCluster.dll   
MatchExpression=/AEM
MatchExpression=/servlet
MatchExpression=/reportfile
MatchExpression=/imagefile
MatchExpression=/dwfile
MatchExpression=/ajsdown
Log=On

Notes:

• The Extension_URI command points to the virtual directory where ApbCluster.dll
resides (/ApbCluster/ApbCluster.dll in this example).

• The MatchExpression command specifies the pages to be redirected.

• The Log command specifies whether logging is enabled. On indicates logging is
enabled; Off indicates logging is disabled.

• The TimeOutcommand specifies the number of seconds the Web server waits between
sending an HTTP request to Appeon Server and receiving information from it. The
HTTP connection timeout value is 2 times of this value.

• The commands and parameters are case insensitive.

8. Activating ISAPI.

Step 1: Select the Web Services Extension.The ISAPI status will be displayed on the
right.

Step 2: Select All Unknown ISAPI Extensions and click the Allow button.
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Figure 6.17: Allow ISAPI

9. Adding new MIME type.

Step 1: Right click the Local computer and select Properties.

Step 2: In the properties window, click the MIME Types button. In the MIME Types
window, click New.

Input the following information:

• Extension: *

• MIME type: application/octet-stream

This is to ensure that pages without extension names or pages without MIME types
defined can be accessed.
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Figure 6.18: MIME Types

10.Restarting IIS.

Restart IIS to make the new settings effective.

Configuring IIS 7.x with J2EE server

J2EE servers refer to Java servers, such as EAServer, WebLogic, WebSphere, JBoss, JEUS
etc. The configuration is the same for the J2EE application servers than Appeon supports.

Choose an existing Web site, or create a new site. The Default Web Site will be used as
examples in the following guide.

1. Copying the Appeon Server Web component to the Web root of the IIS server.

During the installation of Appeon Server Web Component, an IISSupport folder will
be created under the directory which (if you did not specify) is C:\Program Files\Appeon
\WebComponent2013\appeon by default. IISSupport contains files and components that
help IIS 7.x run with the Appeon Server cluster. Check if the appeon\IISSupport folder
exists under the Web root of the IIS server, if not, perform the following steps to copy it
from an existing Appeon Server Web Component installation directory:

Step 1: Create an appeon folder under the Web root of IIS server (for example, C:
\Inetpub\wwwroot).

Step 2: Copy the IISSupport folder from the installation path to the created appeon folder
(for example, C:\inetpub\wwwroot\appeon).

2. Creating a virtual directory.

Step 1: Open Control Panel | Administrative Tools | Internet Information Service
(IIS) Manager.

Step 2: Right click the Default Web Site and select Add Virtual Directory.

Step 3: Input the alias name, for example, "ApbCluster".

Step 4: Choose a local path in the Physical path box; for example, "d:\iisplugin".

Step 5: Click OK.
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Figure 6.19: Add virtual directory

Step 6: Right click the ApbCluster Virtual Directory and select Edit Permissions.

Step 7: Choose the Security tab page, select IIS_IUSRS (WIN-TDTR6ISIYCD
\IIS_IUSRS) in the Group or user names list box, and then click the Edit button.
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Figure 6.20: appeoncluster properties

Step 8: Select IIS_IUSRS (WIN-TDTR6ISIYCD\IIS_IUSRS) in the Group or
user names list box, and then select Modify and Write in the Allow column of the
Permissions for IIS_IUSRS list box.
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Figure 6.21: appeoncluster properties

Step 9: Click OK to go back to the IIS window.

3. Copying Appeon plug-in (ApbCluster.dll or ApbCluster64.dll).

Step 1: Copy the ApbCluster.dll (for 32-bit OS) or ApbCluster64.dll (for 64-bit OS)
plug-in from appeon\IISSupport\modules.

Step 2: Paste it to the newly created virtual directory: C:\inetpub\wwwroot\appeoncluster
in this guide.

In the 64-bit OS, you can either use ApbCluster.dll or ApbCluster64.dll. If you
use ApbCluster.dll, you will need to set the Enable 32-Bit Applications to True
for the AppeonAppPool application pool, as shown in figure below. If you use
ApbCluster64.dll, then set this option to False.

4. Copying Appeon Cluster configuration file (cluster-config.xml).

Step 1: Copy the cluster-config.xml file from %appeon%\repository\<instancename>
\config. %appeon% is the installation directory of Appeon Server, and <instancename>
refers to the name of a server instance.

Step 2: Paste it into the newly created virtual directory: C:\inetpub\wwwroot
\appeoncluster in this guide.

Note: The cluster-config.xml file acts as the redirector configuration file as it helps
Web server redirect requests to Appeon Servers according to the IP addresses of Appeon
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Servers, the ports and load balancing algorithm that it stores. This file cannot be modified
manually and is automatically updated when you change the settings in the Cluster tool of
AEM. Each time after you change the settings, be sure to copy this file and replace the old
file in the virtual directory and restart IIS.

5. Installing Appeon plug-in as ISAPI Filters.

Step 1: Open Control Panel | Administrative Tools | Internet Information Service
(IIS) Manager.

Step 2: Click the Default Web Site and then double-click ISAPI Filters on the right side.

Step 3: Right-click the blank area on the ISAPI Filters page, and click Add.

Step 4: Input ApbCluster in the Filter name box and specify ApbCluster.dll (or
ApbCluster64.dll) as the ISAPI filter in the Executable box (C:\inetpub\wwwroot
\appeoncluster\ApbCluster.dll in this guide). Click OK.

Figure 6.22: Add ISAPI filter

6. Creating the redirector configuration file.

Step 1: Create the redirector configuration file as the name ApbCluster.cfg under the
virtual directory (C:\inetpub\wwwroot\appeoncluster\) in this guide.

Step 2: Copy and paste the following to the file:

Extension_URI=/ApbCluster/ApbCluster.dll   
MatchExpression=/AEM
MatchExpression=/servlet
MatchExpression=/reportfile
MatchExpression=/imagefile
MatchExpression=/dwfile
MatchExpression=/ajsdown
Log=On

Notes:
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• The Extension_URI command specifies the location of the virtual directory which
contains ApbCluster.dll (or ApbCluster64.dll), that is /virtual-directory-alias-name/
ApbCluster.dll (/ApbCluster/ApbCluster.dll in this guide).

• The MatchExpression commands specify the type of pages to redirect.

• The Log command specifies whether to enable logging.

• The TimeOut command specifies the number of seconds the Web server waits between
sending an HTTP request to Appeon Server and receiving information from it. The
HTTP connection timeout value is 2 times of this value.

• The commands and parameters are case insensitive.

7. Setting ISAPI and CGI Restrictions.

Step 1: Open Control Panel | Administrative Tools | Internet Information Services
(IIS) Manager.

Step 2: Right-click the local machine, and then double-click ISAPI and CGI Restrictions
on the right side.

Step 3: Right-click the blank area of the ISAPI and CGI Restrictions page and click
Add.

Step 4: Specify the local path of ApbCluster.dll (or ApbCluster64.dll) in the ISAPI
or CGI path box and input ApbCluster in the Description box, and then select Allow
extension path to execute.

Step 5: Click OK.

Figure 6.23: Add ISAPI or CGI

8. Enabling ISAPI-dll.

Step 1: Open Control Panel | Administrative Tools | Internet Information Services
(IIS) Manager.
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Step 2: Expand the Default Web Site, click ApbCluster, and then double-click Handler
Mappings on the right side.

Step 3: Right-click ISAPI-dll, and select Edit Feature Permissions.

Step 4: Select Read, Script, Execute, and click OK.

Figure 6.24: Edit feature permissions

9. Adding MIME type.

Add a MIME type for loading the files with no extensions or MIME type definition.

Step 1: Click the Default Web Site and then double-click MIME Types on the right of the
page.

Step 2: Right-click the blank area of the MIME Types page, and click Add.

Step 3: Specify the following settings:

• Extension: *

• MIME Type: application/octet-stream

Step 4: Click OK.

Figure 6.25: Add MIME type

10.Restarting IIS.

Restart IIS to make the new settings effective.
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Configuring IIS 6.0 with J2EE server

J2EE servers refer to Java servers, such as EAServer, WebLogic, WebSphere, JBoss, JEUS
etc. The configuration is the same for the J2EE application servers that Appeon supports.

Choose an existing Web site, or create a new site. The following takes the existing Default
Web Site as an example.

1. Copying the Appeon Server Web component to the Web root of the IIS server.

During the installation of Appeon Server Web Component, an IISSupport folder will be
created under the directory which (if you did not specify) is C:\Program Files\Appeon
\WebComponent2013\appeon by default. IISSupport contains files and components that
help IIS 7.x run with the Appeon Server cluster. Check if the appeon\IISSupport folder
exists under the Web root of the IIS server, if not, perform the following steps to copy it
from an existing Appeon Server Web Component installation directory:

Step 1: Create an appeon folder under the Web root of IIS server (for example, C:
\inetpub\wwwroot).

Step 2: Copy the IISSupport folder from the installation path to the created appeon folder
(for example, C:\inetpub\wwwroot\appeon).

2. Specifying properties of IIS Web site.

Step 1: Open Control Panel | Administrative Tools | Internet Information Service
(IIS) Manager.

Step 2: Right click the Default Web Site and select Add Virtual Directory.

Step 3: Click the Home Directory tab and select Scripts only in the Execute Permissions
dropdown list.
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Figure 6.26: Default Web site properties

3. Creating a virtual directory.

Step 1: Right click the Default Web Site and select New.

Step 2: Click the Virtual Directory tab and input ApbCluster in the Application name
box.

Step 3: Choose a local path; for example, d:\iisplugin.

Step 4: Enable read, run script, and execute on the virtual directory. Or select Read and
selecting Scripts and Executables from the Execute Permissions dropdown list.
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Figure 6.27: Apbcluster properties

4. Copying Appeon plug-in.

Step 1: Copy the ApbCluster.dll (for 32-bit OS) or ApbCluster64.dll (for 64-bit OS)
plug-in from appeon\IISSupport\modules.

Step 2: Paste it to the virtual directory: d:\iisplugin.

In the 64-bit OS, you can either use ApbCluster.dll or ApbCluster64.dll. If you
use ApbCluster.dll, you will need to set the Enable 32-Bit Applications to True
for the AppeonAppPool application pool, as shown in figure below. If you use
ApbCluster64.dll, then set this option to False.

5. Copying Appeon Cluster configuration file (cluster-config.xml).

Step 1: Copy the cluster-config.xml file from %appeon%\repository\<instancename>
\config. %appeon% is the installation directory of Appeon Server, and <instancename>
refers to the name of a server instance.

Step 2: Paste it to the virtual directory: d:\iisplugin.

Note: The cluster-config.xml file acts as the redirector configuration file as it helps
Web server redirect requests to Appeon Servers according to the IP addresses of Appeon
Servers, the ports and load balancing algorithm that it stores. This file cannot be modified
manually and is automatically updated when you change the settings in the Cluster tool of
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AEM. Each time after you change the settings, be sure to copy this file and replace the old
file in the virtual directory and restart IIS.

6. Installing Appeon plug-in as ISAPI Filters.

Step 1: Open Control Panel | Administrative Tools | Internet Information Service
(IIS) Manager.

Step 2: Right click the Default Web Site and choose Properties.

Step 3: Click the ISAPI Filters tab page. Click Add to add ApbCluster.dll (or
ApbCluster64.dll). Click OK.

7. Creating the ApbCluster.cfg file.

Step 1: Create the ApbCluster.cfg file in the virtual directory d:\iispulgin.

Step 2: Copy and paste the following:

Extension_URI=/ApbCluster/ApbCluster.dll   
MatchExpression=/AEM
MatchExpression=/servlet
MatchExpression=/reportfile
MatchExpression=/imagefile
MatchExpression=/dwfile
MatchExpression=/ajsdown
Log=On

Notes:

• The Extension_URI command specifies the location of the virtual directory which
contains ApbCluster.dll (or ApbCluster64.dll), that is /virtual-directory-alias-name/
ApbCluster.dll (/ApbCluster/ApbCluster.dll in this guide).

• The MatchExpression commands specify the type of pages to redirect.

• The Log command specifies whether to enable logging.

• The TimeOut command specifies the number of seconds the Web server waits between
sending an HTTP request to Appeon Server and receiving information from it. The
HTTP connection timeout value is 2 times of this value.

• The commands and parameters are case insensitive.

8. Enabling Web Services Extension.

Step 1: Click Web Services Extension in the IIS Manager.

Step 2: Select All Unknown ISAPI Extensions and click the Allow button.
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Figure 6.28: IIS Manager

9. Adding MIME type.

Add a MIME type for loading the files with no extensions or MIME type definition.

Step 1: Right click the Local computer and select Properties.

Step 2: Click the MIME Types button.

Step 3: Click the New button and specify the following settings:

• Extension: *

• MIME type: application/octet-stream

Figure 6.29: MIME Type

10.Restarting IIS.

Restart IIS to make the new settings effective.
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6.3.2.2 Type 2: Apache Web server

6.3.2.2.1 Method 1: Manual configuration

Configuring Apache 2.0/22 with J2EE servers

J2EE servers refer to Java servers, such as EAServer, WebLogic, WebSphere, JBoss, JEUS
etc. The configuration is the same for the J2EE application servers than Appeon supports.

1. Copying the Appeon Server Web component to the Web root of the Apache server.

Before configuration, make sure that you have copied Appeon Server Web Component
from the installation path to %APACHE%\htdocs, where %APACHE% refers to the home
directory of Apache.

a. Create an appeon folder under the Web root of Apache server (%Apache%\htdocs\).

b. Copy the Apache20Support or Apache22Support folder from the installation path to
the created appeon folder (%Apache%\htdocs\appeon).

2. Copying Appeon plug-in.

Copy the mod_appeon2.so or mod_appeon22.so plug-in file from %APACHE%\htdocs
\appeon\Apache2xSupport\modules to the %APACHE%\modules folder.

3. Copying Appeon Cluster configuration file.

Copy the cluster-config.xml file from the %appeon%\repository\<instancename>\config
folder to the %APACHE%\conf folder, where %appeon% is the installation directory of
Appeon Server, and <instancename> refers to the name of a server instance.

Note: The cluster-config.xml file acts as the redirector configuration file as it helps
Web server redirect requests to Appeon Servers according to the IP addresses of Appeon
Servers, the ports and load balancing algorithm that it stores. This file cannot be modified
manually and is automatically updated when you change the settings in the Cluster tool of
AEM. Each time after you change the settings, be sure to copy this file and replace the old
file in the %APACHE%\conf folder and restart Apache.

4. Modifying httpd.conf.

If the application server (such as EAServer, WebLogic, WebSphere, JBoss, or JEUS)
is running on Windows, add the following statements into the httpd.conf file under the
%APACHE%\conf folder (take mod_appeon2.so as an example):

LoadModule appeon_module modules\mod_appeon2.so
<IfModule mod_appeon.c>
MatchExpression /AEM
MatchExpression /servlet
MatchExpression /reportfile
MatchExpression /imagefile
MatchExpression /dwfile
MatchExpression /ajsdown
</IfModule>
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If the application server is running on UNIX/LINUX, add the following statements into
the httpd.conf file under the %APACHE%\conf folder (take mod_appeon2.so as an
example):

LoadModule appeon_module modules/mod_appeon2.so
<IfModule mod_appeon.c>
MatchExpression /AEM
MatchExpression /servlet
MatchExpression /reportfile
MatchExpression /imagefile
MatchExpression /dwfile
MatchExpression /ajsdown
</IfModule>

5. Restarting Apache.

Restart Apache for the new settings to take effect.

Configuring Apache 1.3 with J2EE servers

J2EE servers refer to Java servers, such as EAServer, WebLogic, WebSphere, JBoss, JEUS
etc. The configuration is the same for the J2EE application servers than Appeon supports.

1. Copying the Appeon Server Web component to the Web root of the Apache server.

Before configuration, make sure that you have copied Appeon Server Web Component
from the installation path to %APACHE%\htdocs, where %APACHE% refers to the home
directory of Apache.

a. Create an appeon folder under the Web root of Apache server (%Apache%\htdocs\).

b. Copy the Apache20Support or Apache22Support folder from the installation path to
the created appeon folder (%Apache%\htdocs\appeon).

2. Copying Appeon plug-in.

Copy the mod_appeon.so plug-in file from %APACHE%\htdocs\appeon
\Apache13Support\modules to the %APACHE%\modules folder.

3. Copying Appeon Cluster configuration file.

Copy the cluster-config.xml file from the %appeon%\repository\<instancename>\config
folder to the %APACHE%\conf folder, where %appeon% is the installation directory of
Appeon Server, and <instancename> refers to the name of a server instance.

Note: The cluster-config.xml file acts as the redirector configuration file as it helps
Web server redirect requests to Appeon Servers according to the IP addresses of Appeon
Servers, the ports and load balancing algorithm that it stores. This file cannot be modified
manually and is automatically updated when you change the settings in the Cluster tool of
AEM. Each time after you change the settings, be sure to copy this file and replace the old
file in the %APACHE%\conf folder and restart Apache.

4. Modifying httpd.conf.

Add the following statements into the httpd.conf file under the %APACHE%\conf folder:
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LoadModule appeon_module modules\mod_appeon.so
<IfModule mod_appeon.c>
MatchExpression /AEM
MatchExpression /servlet
MatchExpression /reportfile
MatchExpression /imagefile
MatchExpression /dwfile
MatchExpression /ajsdown
</IfModule>

5. Restarting Apache.

Restart Apache for the new settings to take effect.

6.4 Task 4: Deploy or Install the application to the Appeon Server
cluster and Web server(s)

To install an Appeon application to the Appeon Server cluster and Web server(s), you can
either deploy the application via the Appeon Deployment Wizard (see Appeon Developer
User Guide), or run the deployment project generated by using the Appeon Application
Package Wizard (see Appeon Developer User Guide). This section will talk about how
to install an application by running the deployment project generated via the Appeon
Application Package Wizard.

6.4.1 Points to note before installation

Be aware of the following points before installing an Appeon application:

• The Setup program of the Web application or the mobile application runs on the Windows
platform only. To install applications to servers running on Unix\Linux, you must run the
Setup program on the Windows platform and then install the application to remote servers
running on Unix\Linux.

• The target Web servers must have the Appeon Server Web Component correctly installed.

• The packaged EAServer components, if any, can only be installed to EAServer application
server.

6.4.2 Installing an application

You can copy the generated package to any computer running Windows and install the
application to any number of Appeon Servers and Web servers. Installing an application
using the generated package is the same as deploying an application using the Appeon
Deployment Wizard.

Step 1: Start the target Appeon Server(s) and Web server(s) where you want to install the
application.

Step 2: Run the Setup.exe file in the generated package.

The Appeon Application Deployment wizard is displayed. Click Next to proceed.
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Figure 6.30: Welcome page

Step 3: Select the deploy-config file (config.xml) to ease your configuration of the
installation wizard. The installation wizard will use the settings in the config.xml file.

If you do not want to use the deploy-config file, simply skip this option and click Next to
configure the settings step by step.
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Figure 6.31: Select the configuration file

Step 4: Input the Application Profile Name and the Application URL for the application and
click Next.

The Application Profile Name is used as the application name to identify an application. If
you want to install multiple instances of the same application on the same server, you can
run the setup package repeatedly and specify different Application Profile Name here. For
example, input appeon_code_examples_test as the Application Profile Name in the first
installation, and input appeon_code_examples_production as the Application Profile Name
in the second installation. The Application Profile Name will be used as the application
name to distinguish the multiple application instances on the same server, so they can be run
independently from each other.
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Figure 6.32: Specify Application Profile Name and Application URL

Step 5: Configure and select profiles for the Appeon Server(s) and the Web server(s) where
the application will be installed.

To install the application to an Appeon Server cluster, please create an Appeon Server profile
for each Appeon Server in the cluster. For detailed instructions on how to create the Appeon
Server profile and Web server profile, refer to the Managing server profiles section in
Appeon Developer User Guide.
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Figure 6.33: Specify server settings

Step 6: Select whether to deploy EAServer components.

After NVO components are deployed, you must generate stub/skeleton in EAServer.
Detailed instructions are provided in Generating Stub/Skeleton in EAServer in the Appeon
Migration Guide.
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Figure 6.34: Specify EAServer settings

If EAServer components are used in the application, select the EAServer Components option
and then create connection profiles for EAServers where you want to deploy the components.
Follow instructions below to create EAServer profiles:

• Click Add to open the Edit EAServer Profile dialog box.

• Input the connection parameters: profile name, host name or IP address, port number, user
name and password.

• Click Test to verify the connection and the click OK to finish the creation.

Figure 6.35: Edit EAServer Profile
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Step 7: If the EAServer Components option is selected in the previous step, select the
EAServer profile from the list and the components to deploy. Click Next to proceed.

Figure 6.36: Deploy NVOs

Step 8: Select whether to install AEM settings and data sources for the current application
and click Next.
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Figure 6.37: Deploy AEM settings

Step 9: Specify the destination folder for the undeployment tool and the log file and click
Next.

Figure 6.38: Specify location for the Appeon Undeployment Tool
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Step 10: Specify the destination file and source file that you want to replace for the Appeon
application package, and click Next.

Files (also called "destination file") under the "wcode" folder of Appeon application package
can be replaced by files of the same type (also called "source file"), so that the source file
will be installed instead of the destination file. When you click the Add button, the File
Replacement dialog box is opened. To select the destination file, click Browse to display
the Open file dialog which will automatically open the "wcode" folder of Appeon application
package, so you can conveniently select a file from the "wcode" folder or from its subfolder.
To select the source file, click Browse to navigate to the folder where the source file is
stored.

Figure 6.39: Specify files to replace for the application package

Step 11: Wait while the wizard is installing files and settings.
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Figure 6.40: Deploying the application

Step 12: Once the operation is complete, click Finish to exit the installation wizard.

To run the application immediately, select the Run Application Now option and click
Finish. Or you can run the application later from the Windows Start | Programs | Appeon
Web Application | ApplicationName.

To view the log information generated during the installation process, select the View Log
box and then click Finish. The log file will be displayed.
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Figure 6.41: Deployment complete
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